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NuTiny-SDK-Mini51 User Manual

For NuMicro ' Mini51 Series

The information described in this document is the exclusive intellectual property of
Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NuMicro™ microcontroller based system design. Nuvoton
assumes no responsibility for errors or omissions.

All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.
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1 Overview

NuTiny-SDK-Mini51 is the specific development tool for NuMicro™ Mini51 series. Users can use NuTiny-SDK-Mini51
to develop and verify the application program easily.

NuTiny-SDK-Mini51 includes 2 portions. One is NuTiny-EVB-Mini51 and the other is Nu-Link-Me.
NuTiny-EVB-Mini51 is evaluation board and Nu-Link-Me is its Debug Adaptor. Thus, users do not need additional ICE
equipment.

2 NuTiny-SDK-Mini51 introduction

NuTiny-SDK-Mini51 can support NuMicro™ Mini51 series. Figure 2-1 is NuTiny-SDK-Mini51 for Mini51 series and the
left portion is called NuTiny-EVB-Mini51 and the right portion is Debug Adaptor called Nu-Link-Me.
NuTiny-EVB-Mini51 is similar to other development board. Users can use it to develop and verify applications to
emulate the real behavior. In fact, the real chip MINI54LAN is mounted on the board. The on board chip covers Mini51
series features. The NuTiny-EVB-Mini51 can be a real system controller to design user target system.

Nu-Link-Me is a Debug Adaptor. The Nu-Link-Me Debug Adaptor connects your PC's USB port to your target
system (via Serial Wired Debug Port) and allows you to program and debug embedded programs on the target
hardware. To use Nu-Link-Me Debug adaptor with Keil or IAR Please refer to “Nuvoton NuMicro  IAR ICE driver user
manual “ or Nuvoton NuMicro™ Keil ICE driver user manual” in detail.

LQFP-48 pin
Reset Key Target Chip extended connector Power Selector
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Figure 2-1 NuTiny-SDK-Mini51 (Green Color PCB Board)
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2.1 NuTiny-SDK-Mini51 Jumper Description

2.1.1 Power Setting

® |CEJ2: USB port in Nu-Link-Me
®  JP8: Select 5V or 3V for system power in Nu-Link-Me
® JP2VCC(A): VCC Voltage connecter in NuTiny-EVB-Mini51

POWER model \ ICEJ2 USB port JP8 JP2 VCC(A) MCU Voltage
Model 1 Connect to PC Select VCC3(default) DC 3V output DC 3V
Model 2 X X DC 2.8-5.5V input Voltage by
JP2 VCC(A) input
X: Not use.

2.1.2 Debug Connector

® JP4: Target ICE Connector in NuTiny-EVB-Mini51
® ICEJP8: Nuvoton ICE Connector in Nu-Link-Me

2.1.3 USB Connecter
® J2: mini USB Connecter in Nu-Link-Me
2.1.4 Extended Connecter
® JP5, JP6, JP7 and JP1: Show all of chip pins in NuTiny-EVB-Mini51

2.1.5 Reset Button
®  SWI1: Reset button in NuTiny-EVB-Mini51

2.1.6 Power Connecter

® JP2VCC(A): VCC connecter in NuTiny-EVB-Mini51
® JP3 GND: GND connecter in NuTiny-EVB-Mini51
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2.2 Pin Assignment for Extended Connector

NuTiny-EVB-Mini51 provides MINI54LAN on board and the extended connector for LQFP-48 pin.
Table 2-1 is the pin assignment for MINIS4LAN.

Pin No | Pin Name Pin No | Pin Name
01 NC 25 P2.5, PWM3
02 P1.5, AIN5, CPPO 26 P2.6, PWM4, CPO1
03 IRESET 27 NC
04 P3.0, AIN6, CPN1 28 NC
05 AVSS 29 P4.6, ICE_ CLK
06 P5.4 30 PA.7, ICE_DAT
07 P3.1, AIN7, CPP1 31 NC
08 P3.2, INTO, STADC, TOEX 32 P0.7, SPICLK
09 P3.4, TO, SDA 33 P0.6, MISO
10 P3.5, T1, SCL 34 P0.5, MOSI
11 NC 35 P0,4, SPISS, PWM5
12 NC 36 NC
13 NC 37 P0.1, RTSn, RX, SPISS
14 P3.6, CKO, T1EX, CPOO 38 P0.0, CTSn, TX
15 P5.1, XTAL2 39 NC
16 P5.0, XTAL1 40 NC
17 VSS 41 P5.3, AINO
18 LDO_CAP 42 VDD
19 P5.5 43 AVDD
20 P5.2, INT1 44 P1.0, AIN1
21 NC 45 P1.2, AIN2, RX
22 P2.2, PWMO 46 P1.3, AIN3, TX
23 P2.3, PWM1 47 P1.4, AIN4, CPNO
24 P2.4, PWM2 48 NC

Table 2-1 pin assignment for MINI54LAN

2.3  NuTiny-SDK-Mini51 PCB Placement
Users can refer Figure 2-2 for the NuTiny-SDK-Mini51 PCB placement.
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Figure 2-2 NuTiny-SDK-Mini51 PCB Placement
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3 How to start NuTiny-SDK-Mini51 on the Keil uVision® IDE

3.1 Keil uVision® IDE Software Download & Install

Please connect to Keil company website (http://www.keil.com) to download the Keil uVision® IDE and install the
RVMDK.

3.2  Nuvoton Nu-Link Driver Download & Install

Please connect to Nuvoton company NuMicro™ website (http://www.nuvoton.com/NuMicro) to download “NuMicro™
Nu-Link Driver for Keil RVMDK? file. Please refer the Chapter 6.1 for the detail download flow. When the download
had finished, please unzip the file and execute the “Nu-Link_Keil _Driver.exe” to install the driver.

3.3 Hardware Setup
The hardware setup is shown as Figure 3-1

Figure 3-1 NuTiny-SDK-Mini51 Hardware Setup


http://www.keil.com/
http://www.nuvoton.com/NuMicro
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3.4  Smpl_NuTiny-EVB_MINI51 Example Program

This example demonstrates the ease of downloading and debugging an application on a NuTiny-SDK-Mini51 board.
The example can be found on the Figure 3-2 list directory.

Director C:\Nuvoton\BSP Library\Mini51SeriesBSP\NuvotonPlatform_Keil\Sample\NuTiny
y \Smpl_NuTiny-EVB_MINI51
Select Project File e () |
@Qv| |« NuTiny » Smpl_NuTiny-EVE_MINI1 [l Search Smpl NuTiny-EVB_MIN... 0 |
Organize « Mew folder B= ~ '@
. CMSIS o Name ’ Date modifj
: zz:mnplaﬁwmjm ] Smpl_NUTINY_MINIL.uvproj 2011/11/28
MuveotonPlatform_Keil
. Include
Project File -
Driver 3
. Nu-LB_Mini51 W
. NuTiny
Smpl_NuTiny-EVE_MINI
Src - 4] m +
File name:  Smpl NUTINY_MINI51 . uvproj A [PH)JECtFI|E;(’.UVprDj,‘*‘UVmp\A v]
I Open |vl [ Cancel ]

Figure 3-2 Smpl_NuTiny-EVB_MINI51 Example Directory

To use this example:

| Start uVision

o Q Start debug mode
[ | Open the Smpl_NUTINY_MINI51.uvproj project Using the debugger commands, you may:
file
Project-Open T
: : [ | & Single step through code
B Compile and link the Smpl_NUTINY_MINI51

application [ Run the application\

;:

g 'F-

Project - Build

SO ) u |=ﬂz T ‘ Review variables in the watch window
B Program the application into on-chip Flash ROM

Chifm
oy B PRET Reset the device to re-run the application
Flash — Download

The LED will toggle on the NuTiny-EVB-Mini51 board.
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4 How to start NuTiny-SDK-Mini51 on the IAR Embedded Workbench

41 1AR Embedded Workbench Software Download & Install

Please connect to IAR company website (http://www.iar.com) to download the IAR Embedded Workbench and install the
EWARM.

4.2 Nuvoton Nu-Link Driver Download & Install

Please connect to Nuvoton company NuMicro™ website (http://ww.nuvoton.com/NuMicro) to download “NuMicro™
Nu-Link Driver for IAR EWARM?” file. Please refer the 6.2 for the detail download flow. When the download had
finished, please unzip the file and execute the “Nu-Link_IAR_Driver.exe” to install the driver.

4.3 Hardware Setup
The hardware setup is shown as Figure 3-1

Figure 4-1 NuTiny-SDK-Mini51 Hardware Setup


http://www.iar.com/
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4.4 Smpl_NuTiny-EVB_MINI51 Example Program

This example demonstrates the ease of downloading and debugging an application on a NuTiny-SDK-Mini51 board.
The example can be found on the Figure 4-2 list directory. (Samples code can be download from Nuvoton website)

Director C:\Nuvoton\BSP Library\Mini51SeriesBSP\NuvotonPlatform_IAR\Sample
y \NuTin\Smpl_NuTiny-EVB_MINI51
ﬁ Open Workspace ﬂ‘
« NuTi... » Smpl_NuTiny-EVE_MINL... » - Search Smpl NuTiny-EVE_MIN...
Organize New folder B= - [ @
J Mini515eriesB5P_v1.00.002 “  Name ’ Date modifi
. CMSIS
Debug 2011/11/28
Doc [ 4] Smpl_NUTINY_MiniSLeww 2011/9/7 17
. NuvotonPlatform_IAR
. Include
Project File > H
. Sample =
Driver | &
Mu-LB_Mini51
MuTiny
. Smpl_NuTiny-EVE_MINI
settings o || I |+| b
File name:  Smpl_NuTINY_Mini51 eww - [WorkjpaceFiles {*.eww) V]
[ Open ‘v] l Cancel I

Figure 4-2 Smpl_NuTiny-EVB_MINI51 Example Directory
To use this example:

[ | % Start IAR Embeded Workbench

B Openthe Smpl_NuTINY_Mini51.eww workspace
file
File-Open-Workspace

B Compile and link the Smpl_NuTINY_Mini51
application

oo
4% Project - Make

B Program the application into on-chip Flash ROM

& Project — Download and Debug

The 1/O will toggle on the NuTiny-EVB-Mini51 board.
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5 NuTiny-EVB-Mini51 Schematic
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6 To Download NuMicro™ Family Releated Files From Nuvoton Company

6.1 To Download NuMicro" Nu-Link Driver for Keil RVMDK

Stepl | To connect to the Nuvoton NuMicro™ Website: http://www.nuvoton.com/NuMicro

Click here to enter
Device Driver and
Software Library page

Home W\ Product & Sales \ Product Lines \ Industrial IC \ ARM Migrecontroller | ARM Certex™-M0 NuMicro™ Family

ARM Cortex™-M0 NuMicro® Family

nuvoTon
NuMicro® Family is Nuveton's brand-new 32-bit Microcontroller produgtfine based on the ARM® Cortex™-MO processar
. ™ .
¥ ¢ with rich peripherals to offer superb features and connectivity capgaii ides the NUC100, NUC120, NUC130 and
NuMicro; Fami , ; _ fures and conneciiity Hs
W NUC140 series, a new series the NuMicro MOS1™ series, in 1516 is to satisfy the worldwide

customers’ 8-bit16-bit microcontroller demand with a high t microcontroller.

Step2 Cortexi: ;

Products Development Resources News and Events
® WCU Products Brochure ® Products Brief, DataShest = MdTiny Quick Start = MNuMicro® NEWS List
+ English ® Technical Reference Manual Online Training + Jun. 8. 2011
» Chinese = DevelopmentTools __ __ _  __ ® MCU Forum Muvoton NuMicro™ Family 32-bit Microcontroller
* DM Download | » Device Driver and Software Library = FAQU Debut a New Series-NUC122
® Online Products Selection 5 Nullicro ﬁveﬁprﬁnﬁmﬁ - = Events
® Distributor Information » Third Party Tools + Dec. 12-20. 2011
® Migration Guide MNuvoton MuMicro™ Wini51 Training on Tour
® Application Motes a
Programmer Software Tools Fackage
—
File name Description Version Date
& icP Programming Tool V1.18.5320.21 . e
are g n NuMicro IGP tool & user manual V1.18 5320 | 11-24-2011
Change History
& 1sP Programming Tool V1.41.zi . . .
g g p MuMicro 13P Programming Tool & user manual V1.4 To download

Change History the file

q NuGang Programmer V5.7 3.zip
Step 3 ﬁ{:hange History

MuGang Programmer software & user manual

Nu-Link Driver

File name Description Version Date
. . . . This driver is to support Mu-Link recognized by
2 hu-Link Driverfor Keil RVMDK V1.18.5320.zip Keil RVMDK Development Environment and V1.18.5320 | 11-24-2011 I
Change History support all MuMicro Family Devices selectable.

. . . This driver is to support Nu-Link recognized by
% Nu-Link Driver for AR EWARN V/1.18.5320.2ip IAR EWARM Development Environment and V1.18.5320 | 11-24-2011
Change History support all MuMicra Family Devices selectable.

Step 4 | To download the NuMicro™ Nu-Link Driver for Keil RVMDK

11
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6.2 To Download NuMicro" Nu-Link Driver for IAR EWARM

Stepl | To connect to the Nuvoton NuMicro™ Website: http://www.nuvoton.com/NuMicro

Click here to enter
Device Driver and
Software Library page

Home W\ Product & Sales \ Product Lines \ Industrial IC \ ARM Migrecontroller | ARM Certex™-M0 NuMicro™ Family

ARM Cortex™-M0 NuMicro® Family

nuvoTon
v NuMicro® Family is Nuvoton's brand-new 32-bit Microcontroller produgtfine based on the ARM® Cortex™-M0 processor
. ™ - e ) - - ’ .
T with rich peripherals to offer superd features and connectivity cap s the NUC100, NUC120, NUC130 and
NuMicro) Family, , ; _ ures and conneciid Hos =
'W_)_ NUC140 series, a new series the NuMicro MOS1™ series, inghiding ! 1516 is to satisfy the worldwide

Step2 'Qﬂex customers’ 8-bitf6-bit microcantroller demand with a high t micracontraller.

Products Development Resources News and Events
® WCU Products Brochure ® Products Brief, DataShest = MdTiny Quick Start = MNuMicro® NEWS List
+ English ® Technical Reference Manual Online Training + Jun. 8. 2011
» Chinese " DevelopmentTools __ _ __ __ ® MCU Forum Muvoton NuMicro™ Family 32-bit Microcontroller
* DM Download » Device Driver and Software Library = FAQ Debut a New Series-NUC122
® Online Products Selection ~ Mulicro ﬁveﬁprﬁnﬁmﬁ - = Events
® Distributor Information » Third Party Tools » Dec. 12-20. 2011
® Migration Guide MNuvoton MuMicro™ Wini51 Training on Tour
® Application Notes 0
Programmer Software Tools Package
—
File name Description Version Date
& icP Programming Tool V1.18.5320.21 . e
are g n NuMicro IGP tool & user manual V.18 5320 | 11-24-2011
Change History
& 1sP Programming Tool V1.41.zi . . .
g g p MuMicro ISP Programming Tool & user manual V1.4 To download

Change History the file

q NuGang Programmer V5.7 3.zip
Step 3 ﬁ{:hange History

Nu-Link Driver

MuGang Programmer software & user manual

File name Descriptip Version Date

This driver is to supednt Mu-Link recognized by

Keil RVMDK De#Elopment Environment and V1.18.5320 | 11-24-2011
Wllicrg Eamily Deviges selecfable 1

. . . This driver is to support Nu-Link recognized by
0 hu-Link Driver for IAR EWARM 1.18.5320.ip IAR EWARM Development Environment and V1.18.5320 | 11-24-2011 |

& change History support all MulMicro Family Devices selectable.

q Nu-Link Driver for Keil RVMDK V1.18.5320.zip
ﬁ{:hange History

— — — — — | SWARPOL

Step 4 | To download the NuMicro™ Nu-Link Driver for IAR EWARM

12
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6.3 To Download NuMicro™ Mini51 Series BSP Software Library

Stepl | To connect to the Nuvoton NuMicro™ Website: http://www.nuvoton.com/NuMicro

Click here to enter
Device Driver and
Software Library page

Home W Product & Sales \ Preduct Lines | Industrisl IC | ARM Micrecontroller |\ ARM Cortex™-M0 NuMicro™ Family

ARM Cortex™-M0 NuMicro® Family

nuvoTon

s NuMicro® Family is Nuveton's brand-new 32-bit Microcantroller produgtfine based on the ARM® Cortex™-10 processor
§ with rich peripherals to offer superb features and connecivity cap . s the NUC100, NUC120, NUC130 and

NUC140 series, a new series the NuMicro M051™ series, inghdding U 516 is to satisfy the worldwide

-bit microcontroller demand with a high micracontrolier,

Step2

< Products " Development Resources  Techniga < News and Events
® MCU Products Brochure ® Products Brief, DataSheet ® NdTiny Quick Start = NuMicro® NEWS List
+ English = Technical Reference Manual Online Training + Jun. 8 2011
» Chinese = DevelopmentTools __ __ __ __ ® MCU Forum Nuvoton NuMicro™ Family 32-bit Microcontroller
= DM Download + Device Driver and Software Library FAQ Debut a New Series-NUC122
® Online Products Selection > Hulicro Eveﬁprﬁnmuﬁ - ® Events
= Distributor Information » Third Party Tools » Dec. 12-20. 20M1

= Migration Guide Muvoton Nulicro™ Mini51 Training on Tour
= Application MNotes "

Board Support Package

File name Description Version Date
e e e e e e e e e e e e e e e e e e e .
I Mini51 series software package based on
CMSIS version 1.3, It supports both AR and Keil I
2D Minis1 SeriesBSP_CMSIS V1.00.002.zip development environment with drivers and v1.00.002 | 11-14-2011
I Mini51 Series Driver Reference Guide \1.00.001 samples codes. Examples source code for -.:.-1'00'001 14-14-2011
'@Change History MuTiny-Mini51 and Learining Board are o
I included. For detailed, please download it and I
unzip it.

oftware package based on CMSIS

&2 m051SeriesBSP_CMSIS V1.02.002.zip JerEion 13 1L bot bR End kel | v1.02.002 | 06.08-2011

) ] ) development envirohsgqent with drivers and V1.02.002 -09-2
ﬁ Mos51 Seljes Driver Reference Guide V1.00.005 samples codes. Examphsg source code for ¥1.00.005 | 07-18-2011
'@Change History MuTiny-M051 and Learining Beard are included.

For detailed, please download it 2sgd unzip it.

Step 3

M051 series software package based o
f@ M051 SeriesBSP_RegCtriPrg V1.00.002.zip register programming coding rule for sampl
code & user guide.

MUC100 series software package based on
CMSIS version 1.3, It supports both AR and Keil
Eﬂ NUC1005eries BSP_CMSIS V1.05.002.zip development environment with drivers and V10
; . ; samples codes. Examples source code for e
%NUCWO S.enes Driver Reference Guide V1.05.001 NUTiny-100120130/140 and Learining Board V1.0
Change History are included. For detailed, please download it
and unzip it.

To download
the file

NUC122 sofiware package based on CMSIS
E@ HUCA22 BSP_CMSIS V1.01.002.7ip version 1.3. It supports both IAR and Keil

) ] development environment with drivers and V1.01.002 | 09-08-2011
ﬁ NuC122 pnver Reference Guide V1.00.002 samples codes. Examples source code for ¥1.00.002 | 07-18-2011
Change History MuTiny-122 are included. For detailed, please

download it and unzip it.

Step 4 | To download the NuMicro™ Mini51 SeriesBSP_CMSIS software library

13
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7 Revision History

\Version Date Page Description

1.0 Nov. 29, 2011 |- Initial Issued
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Important Notice

Nuvoton products are not designed, intended, authorized or warranted for use as components in systems or
equipment intended for surgical implantation, atomic energy control instruments, airplane or spaceship
instruments, transportation instruments, traffic signal instruments, combustion control instruments, or for other
applications intended to support or sustain life. Further more, Nuvoton products are not intended for applications
wherein failure of Nuvoton products could result or lead to a situation wherein personal injury, death or severe
property or environmental damage could occur.

Nuvoton customers using or selling these products for use in such applications do so at their own risk and agree
to fully indemnify Nuvoton for any damages resulting from such improper use or sales.

Please note that all data and specifications are subject to change without notice. All the trademarks of products
and companies mentioned in this datasheet belong to their respective owners.
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